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The DNA of a CAS Firm

One firm’s journey to world-
class client services

Laura Redmond

#QBConnec t | WiFi: QBConnec t






CPE credit administered
in coordination with

CPE Process @ crrocademyorg @

In order to receive CPE credit
- Be sure to sign in or scan your badge for this session

- You must stay in the session for the duration of the training
- This session is eligible for 1 hour of CPE

- CPE certificates are emailed directly to you within 4 weeks of the conference date to the
same email address you used to register

@ Quiickbooks.
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About today’s speaker

2019 Top CAS ProAdvisor, |1A
2015 Top 20 Firm of the Future, Intuit

2014 Leading QuickBooks Online Practice, |1A

Founder, Redmond Accounting Inc

Co-founder, Aero Workflow

Laura Redmond
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Vision > Leadership

Core values

Core focus

Marketing strategy

Target
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Vision > Leadership > Core Values

Creote WON
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The foundation of your
company's culture

 List people you admire
 List what you admire

« Select 5 - 10 core values

10



Vision > Leadership > Core Focus

* Why you are excited to
wake up and come to work

+

 What you do well and enjoy
doing

@ Quiickbooks.
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Vision > Leadership > Core Focus

@ Quiickbooks.

CONNECT

Simple language

Big & bold

Ah-ha effect

Comes from the heart
Not just about money

Bigger than a goal

12



Vision > Leadership > Marketing Strategy

Target market

Lead Generation

Three uniques

Proven process

Guarantee

@ Giickbooks.

CONNECT
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Vision > Leadership > Target

@ Guiickbooks.

CONNECT

Total revenue
Average client revenue
Client count

Staff count

14



Vision > Traction

LEVEL 10 MEETING

Good news

Scorecard: on / off target
Rock review: on/ off track
People headlines

To-Do list: done / not done
Issues: identify, discuss, solve

Conclude

@ Quiickbooks.

CONNECT

9 mins
S5 mins
S5 mins
9 mins
9 mins
60 mins

5 mins

15



Vision

@ Quiickbooks.

CONNECT

(o, )

What do you want?

Resonates with everything else you do

16
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Process > Marketing > Branding > message
Hew
S

M
o WHY
W ReRE

@ gliickbooks.
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Process > Marketing > Branding > style

Typography
Typography
Typography
Typography
Tvpographj

@ gliickbooks
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Process > Marketing > Lead Generation > target market

@ Quiickbooks.

CONNECT

Country: United States
Revenue: 1M to 10M

Industry: Professional services
Technology: QuickBooks
Position: Most senior contact

Email Type: Verified

21



Process > Marketing > Lead Generation > blog

REDMOND ACCOUNTING INC Wore  Seves  Moas  Bng  ame ek Do
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Process > Marketing > Lead Generation > email campaign

@ Quiickbooks.

CONNECT

What is CAS? Mon, Jul 29, 1:06 PM

Hey Laura,

| recently spoke to a business owner who was confused by the varying services offered by different
accounting firms. Think about it this way. One engineer builds software; another builds bridges. One
attorney works in civil legalities; another pursues criminal cases. The accounting profession also has
specialties such as Tax, Audit and Client Accounting Services (CAS). What is CAS?

It's the equivalent of a business' accounting
department, performed by an accounting firm.
CAS practice is one of the fastest-growing in the
profession. Progressive firms perform day-to-day
accounting functions so you don't have to carry
the burden of staffing, supplying, hiring and

2 managing an accounting team.

| We love what we do. But it's no fun until we share it
with you! Reach out 1o us or forward this email to
someone you know who needs us.

Thanks again!

Sent to’ BUBDOAmMONIACCOLNNG Com
Don't want future emalls? Unsubscribe

23



Process > Marketing > Lead Generation > social media

R Redmond Accounting Inc e

69 followers

2w
QuickBooks Tip: Receipt Capture
Credit card expenditures should have a receipt attached, showing the itemized
details of the purchase. One great way of managing receipts is by using
QuickBooks Online’s newly released Receipt Capture feature. Read blog...

T Receipn e (o)
| =0 , -

— & = P

gal n--.—dbw::r--—-—-“ e e bty o

b Fo w———

QuickBooks Tip: Receipt Capture

redmondaccounting.com

@ Gliickbooks.

CONNECT
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Process > Marketing > Lead Generation > website

REDMOND ACCOUNTING INC W Sam  Mos  Boy e el Q
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Process > Sales > Lead Qualification > schedule appointment

REDMOND ACCOUNTING INC Nove Sevem Mo Doy die  wmDee  Q

@ Seclect a Date & Time
/ Ociobes 2019 { > Tuesday, October 8
Peadmorst
T oo . -c "y e “w
Welcome --
o ™ mis . ‘. .
S 454

v e senvces we ofter ang

This 152 V- mimute web meeting 10 ' ° ® ©

Setormine 1 we are » solsion for your
BANe s’ reCuTINg ACCounting
DA Nees . g v 23 4 24

29 30 n

O Poche Tore LS A Convada (2430m) »

@ Gliickbooks.
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Process > Sales > Lead Qualification > right fit

REDMOND ACCOUNTING INC Nowe Sevem Mos Doy e O Q

€« Vo Enter Details
@ Pt Narve * Lot MName *

w
Reamone
Welcome -
o 15 min
a 9.308m - 2458, Tuseday, Oclober
8, 201 Compary Nerve *

€ Pacifc Tire - US & Canade

Yoret tte -t O

Are you comfortelle working with your accourting Separimerdt
visaly erth Guact Books Ordine ot 1he cote sccountng program’
10w WO US- bined sl 9 ol wirk onsde aad o Not Support the
Besadag werssin of QuehBooks | ©

o Yes Lourrenty use QuickBooks Onine
1 Yes, | s wiling 10 switch 10 QuickBooks Onine
No

@ Gliickbooks.

CORNECT #QBConnect @Redmond_Laura



Process > Sales > Lead Qualification > cost calculator

REDMOND ACCOUNTING INC N Sevem Moot By ki O Q

Accounting Department Cost Calculator

UNe 0nsr CHOAMDS D0 Setprvere Deresdl COMTE M0 10 20 1) Mowis 2 (Pl Eng Coputive et
Ok the Une Typiaal Conts batnon 10 guathly S i Comenon amounts. Make (hanges, 4 seeded, and Chaa Calovinme

Wee Tppecal Cosn

Cont of SLafY Accowniant Agdtonsl Coats
MHourly cate Your wperviuon hoart per week
100 300
Hown per wved Your hring & tarsag houn [ yea
hotead woe
Payol S awes b worany comgi Youw Moty vabee
150 ¥ 00
L ) CPA Omanup Mows | o
oo 0,
Betan et .
e
i
e Catcutate
G P p— Monthly Cost = $6020.11
108

@ Gliickbooks.
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Process > Sales > Needs Assessment > business info

miu

@ Giickbooks.

CONNECT

Needs Assessment

Money In

Questions related to money coming into the business by customers, clients, patients, donors,
etc. We do not perform this service, however the method in which revenue is recorded on the
books is critical to the rest of the work that we do.

Method used for recording sales and collecting payments from
customers

Choose v Choose

Revenue process *

Explain current workflow process for recording revenue and collecting payment from you
customers, including software programs used and who performs this work

None

Invoice customers, paper check payments taken to bank for deposit

Your answer
~Invoice customers, electronic payments automatically deposited at bank

*
Payment methods acceptEd from JOus customers Online webstore / E-Commerce

D Check Physical store with Point of Sale register

D Credit Card Physical restaurant with Point of Sale register

D Wire Practice management tool invoices and collects from patients in office
(] AcH 3rd party medical billing service

M rach ~ Automated recurring charges

29



Process > Sales > Needs Assessment > gb access

REDMOND ACCOUNTING INC Nove  Sevem Aos Mo dem  SmDewe  Q
QuickBooks Online

If your Business i usng OuchBooks Onime, ploiso TOROw these RSTUCTONS 10 vile vt 10 SO00SS I &8 80 ASCOUNIAn! User:
1 Log i %o Quickdicoks Oniine as an Admin or Accountant User
2 Select e Gaar 1000 at 1he 109, then chooss Manage Users
3 Chch T Adcounting Fams b
4 vty your accountant:
1.0 1008 15 yOur first 2eme Iwiling a0 ACCOUrSaT, anter Our Sem's amal a00ress QDOPrOOTEAMONdecOIUNtIng 0om. Phen select Invie.
2.0 e’y o ansinyg ACCOUrtant user. Select Inwie B The 100 AT anxd e enter our Temr's emad s0dress gboproGredmondaccounting com. Then
sact rrvite
Note: You can invite up 10 2 accountants. ¥ you wee Quickiiooks Online AShvenced, you can imwile 4p fo 1
ASSrg an Accouniant uter Soes At Sount Ioward your user St

QuickBooks Desktop

i your Buainess s using OuckBBocks for Mac or OuchBocks Pro, Fremer o Erterprne for Windowa, plesse olow 1hese rafructions 10 send that datafie %o us:
L Croste o potatie Tie of e Oucaliooks Deskiop data Ne
2. Upload Tt portalie Se 10 & web Danad 1oider of your chinde, Such 88 Coogie Dvive (prefered).

3. Srare accens 1o Tl foider with s o gRopro@redmondaccounting. com
4 Send the QuckBooks admin Usermame and passwond 10 us ot

aoa-aga‘t“‘

O

OC..

@ Quiickbooks.
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Process > Sales > Proposal > meet

@ Quiickbooks.

CONNECT
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Process > Sales > Proposal > demo

@ Guiickbooks.

CONNECT

USD 11.200.00

32



Process > Sales > Proposal > data analysis

@ Giickbooks.

CONNECT
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Process > Sales > Proposal > options

TEAM PLAN CORE PLAN GURU PLAN
Scalable solutions Powerful efficiency Solid framework

$ $ $

Srutrw v v v

CrOCat v v

Forecast & Budget v

Cash Flow v

et Aradyss v

Reconcie and Close v v

Aduatrg Journsn v v

Bara Feed v

Maraged Workfion v v

o v

- /

@ Gliickbooks.
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Process > Sales > Proposal > client engagement

@ Gliickbooks.

CONNECT

SRR
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#QBConnect @Redmond_Laura

My Test Comparry

SecdTord ACCourming TC

1. Structore

o Systen Archtecture
v Chast b
o Geren B

2. Accounting

= Rscorche & Revien, Monivy
o Closs, Manthdy

o Caah Midw, Monttvy

o Cormroler Call Monthey

= Regorseg, Avslatve J4/7

1 Bockhneepenyg
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Process > Sales > Proposal > welcome email

Men, il 22, . 405 PM

. . -
This is your confirmation that proposal #00 for was accepted, For your reference here is 8 link 1o your engagement letter,
Ploase compiate the steps below 1O ot started with us:

1 Look for an email invite 10 Client Hub within the next 24 hours on reguiar business cays

2 Accept the invite and set your password
3. Downioad the OS or Android app for Client Hub on your smartphone and jog in

4. Chick this fnk 10 schodule a Kickoff Meeting with us to discuss:

* How we communicate
e How we gather info that we need In order to start setting uUp your services

Here is 3 vwdeo overview of this pvocess

@ Gliickbooks.

CORNECT #QBConnect @Redmond_Laura

36



Process

@ Quiickbooks.

CONNECT

(o, )

How will you get there?

“This is how we do things here”

37



Agenda

Vision
Process
System

Results
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Process > Sales > Proposal > task assignment

7 M. Ao
© T Yemngs '
5T 9 Set up Aero Workflow Aero
p Froposal Accepted
P M lipaion L O] Sctup Preview m

$ Proposal Acorpred

o Pemcrics igucion L slivedm

& Tost This Step

4 o Aava Type wiive
B auacn © MCON
‘ Find Company o Sheduled Start Duoe vepaes T O
now —o
+
o Asuipned T renerndt
v.nte Laurs Rpcmond

@ Quiickbooks.
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System > Onboarding > Phase #1 Welcome Client

‘aero v Veuge Sep Oucilions Uy Asw e iner Lagor ©

Client Onboarding Phase #1: Welcome Client
Narve Cevorgtan Aesourcen
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Ortoardng Sabes Tace”

Glients » Update ‘Chert Orbosrding Setun GErwets > Fie > Puties "Chet Ortoarding Statas

Trachar” for s Phass 14 10 “In Progres Tacaer’ - grad Ik 1 putiemed page

Bangy A Ol M0 *
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"New Erployse” form ek
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System > Onboarding > Phase #1 > status tracker

Client Onboarding Status

TASK STATUS STARTDATE DUEDATE % COMPLETE NOTES
Welcome Client In Progress 40412019 492019 0%
Kickol Meeting 4792019 4102019 0%
Gather Info 4102019 8172019 0%
e Jonaee 8112019 8672019 0%
Transition Meeting S8/2019 772019 0%

@ Giickbooks.

CONNECT



System > Onboarding > Phase #1 > invite client

Redmond Accounting Inc has invited you to ClientHub ® 2

ClientHub <maligun@masl chenthub me> Wed, Ape 17, 10.03 AM o & Reply to all

°d’ Client Hub

Mobile App for iOS and
Android available!

Scan the QR Code below, install
the app and start exchanging

Redmond Accounting Inc has invited

you to join them on Client Hub GISORASE ST Seom

anywhere.

. Or access clienthub. app/#/install from your
https J/clienthub.app/#/registration/join/c2259%afe-6132-11e9-9cc4- mobile davics

QWERTYU I OFP

A SDFGHUJKIL

& 7 X OV RNM&

Mobile Apps available for iOS and Android

& AppStore > Godéle Play

@ Quiickbooks.
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System > Onboarding > Phase #1 > prep next phase

:

-
-

Schedule "Kickoff
Meeting" with client

|

Update "Onboarding
% Status Tracker"

|

1 Schedule
aero Phase2 tasks

@ Gliickbooks.

CONNECT

Send Welcome email to client to schedule "Kickoff* meeting with client,

sales team, and onboarding team

Update "Client Onboarding Status Tracker® for this Phase to "Done"

Schedule Aero for OB Phase #2 - Kickoff Meeting
with Client (make sure this is done automatically
when client sets appt)

44



System > Onboarding > Phase #2 Kickoff Meeting

‘aero L) Vo Sy Qo Lewn vy Az M e Logof o

Client Onboarding Phase #2: Kickoff Meeting

Mo Croemgtome Nosmuan
Upciate ‘Ot Ortosaing Stans Dacker” kor B
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FOOAUOe yOur e, speculy e wac Srare 10 regarSeg \eer merOey
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Al Gl 30 M Do Sissas Wl N 1 0 Cland
A el rwven P & g dopgettee
corwaraatiorn. ached Mrva acea Waa

Osve ¢ OF o v >y 1 Naonad beva aler waf I Sy aamatng eructan 3 Nanaton reetng
I L E

Wig @ meetng snd say goodtye
OuOuns oy Cacs Wil TOMSNG T i rew

Drigonsd reatnd? Crastn Wy spwiisl savvs, #
)

I g
Send wrvary 10 et
Upciste “Clert Ontosrding Shatus Tacher” for s Phass to "Oore”’

Schudie Aums for O Phase 3 - Outher o
@ Gliickbooks.
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System > Onboarding > Phase #2 > client hub training

- Conversation Q %o - - Tracked items - Links
MESSAGLS 1S ML OFEN Remindall  Apps Manage
Dianve Coormal © 0 00 Wy T Oon QuickBooks
Walch Clhient Hub Welcome Video,
Mark a8 done 3 :::‘m
Diane Cuormok 11 £ A0 Wb 1] Opes & & Expensity
Bark Access - Please provide a list of Bank Expemee Mansgerment
Names and Account Numbers that your Custo
2 Select a Hhe v uplosd t Tickets
*  Suppon
Dhmme Cwormek 00 0 Tnper
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System > Onboarding > Phase #2 > prep next phase

Post link to client
e y with instructions

for Next Steps
‘ Send summary to client
Y
Update "Client Onboarding Status Tracker" for this Phase to "Done”
Update "Onboarding
Z2)  status Tracker" Schedule Aero for OB Phase #3 - Gather Info

1 Schedule -
aero Phase3 tasks

@ Gliickbooks.

CONNECT




System > Onboarding > Phase #3 Gather Info

‘aero Wos Ve won -z Ok Lo ey Ll o ol Ml lmew Loy o o

Client Onboarding Phase #3: Gather info

Mo Cwesrplmas Mewoe os

Updete "Oherd Onbosrting Status Trachker” r e
Praes 12 " Pogres”

Oneck of horm beow. aa mosived » Ohert s W DO 8 A 20 Tw Duarwss Ousetionnan 30 CORCT Mo Jetait Tu sees Y08 COBecied DTG e M

P Chaching OF T AnS Onleming Tl 8000 Sy DYDOSEA, AUON B8 DNONe mamter Lagal Buaress Name, DEA Hame, setote, sodwss, TON / Tas © £, ows tax erany

T LORNshe Classicaton Som Propretcr, Parening, LLC ngie. gyt maml, §-Corp,. C-Cop oot Limied Laoeey
Parrwitg. NACS 0ooe W Paaty Tunosl soon Sowmiamed T Mporing. s00 Duaresd emnaiogy @ D
BSOSO, PPN IOONENt A0 T Tassress

Updiate ‘Tt Codountvng Saatus Dok’ S T
e b “Dove’

Botwihie At Nr O Praie 08 St

mfu

CORNECT #QBConnect @Redmond_Laura
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System > Onboarding > Phase #4 Setup Structure

aer0 ne v v DU A it e

Client Onboarding Phase #4: Setup structure
Newve Cwnereplum el

Wpaiate ‘Cient Oroowrang Szana Yeose' bor o
Pt 10 W Pogre

St Chort vl Wi chert B Trare com '

Senp T oo b hart pora *

Cruite 5ig 0 33 00 ae) wihet Lonats Mo Cowre Worm araie e L
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et
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System > Onboarding > Phase #4 > setup email

My Ticker s o

L1
Varbetrg -
Laken

@ Quiickbooks.

CONNECT
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System > Onboarding > Phase #4 > setup apps

QBO: Setup - create client company for new business

Name

Adcd Client

Team

Access new

Setup Wizard

Description

Expensify: Configure Policy Connections

Last Modified 9/18/2015

Resources

Log in to QBOA. Left Navigation Bar > Your Practice > Clents. Click Add Client button on top -l
right hand comer of screen

Enter contact information for new business. Click Next button

i

Your n

|

The s

step” |

i1 13

QBO: Setup - create client company

Last Modified 2/1/2018

Author: Victoria Cameron
« Create New QBO Company

o Start from your client list and select Add client in upper right h:

o Enter Client Contact info

o Select QuickBooks Products

o Add Team Members from your firm that will need to access the

« Then access the client company from your client list by clicking the C

Noturn o

Roch Cantie Construcdan o
el <
©

©

1 PR WO Garyee

T raccephed arsact

Last

Name

& N EIExpensify

Author: Laura Redmond

In the Direct Connections section, click QuickBooks and select Connect to QuickBooks Online.
« If this is your first policy created for a given QBO company, click Connect to QuickBooks. Follow instructions

BDC: Setup - create client account

Description

Log in 1o BDC accountant console > click Manage Consocle button > click Add Clent Company
button. Comnplete relevant information and Save to create new BDC subscription.

Return 1o Clent List and click to access new BDC account

The first time you enter a new BDC client, if you had designated the Accounting Software as QBO,

you will be prompted to sync with QuickBooks Oniine. Click the button to connect to QuickBooks.

Gear > Settings > Sync Preferences: Review defaults and be sure 10 update any left blank or
incorrect,

Navigate to Gear > Startup Checkist to configure appropriate settings

Gear icon > Startup Checklist > Inbox: Specify custom inbox emall address and fax number

Gear icon > Startup Checkiist > Bank account: Link bank account. Verify personal information to
confirm you are who you say you are. Then enter your client’s bank account information. Then
follow instructions 10 verity account (fastest mathod is via online access).

Gear icon > Startup Checklist > Approval: Configure bill approval workflow

it you want to link to
sser (Master Admin,
;

Resources 'ded by Expensify.
ing Connection and

(Y]

o

ow



System > Onboarding > Phase #4 > schedule recurring service

Assigned To*

Company VRC

Repeat Every
1st Occurrence*
Repeat Until

OR Ends after

mtu

qulckbooks

CONNECT

10/3/2019 9:56 PM

0 occurrences

Diane Csornok

“«»

‘ Work  Manage Setup OuickLinks Librry  Admin Helio aura!  Logoft ©

QBO: Banking Feeds 8

Name Description Resources
v Confirm bank  QBO > Left Nav > Banking. Confirm that bank connection is active for town
cth appropeiate bank s & crecit cards If date of last update isn't within last
24 hours, click Update. Some accounts need to be Updated manually
Select accout  Each bank and credit card account connected to QBO will show as a card / tile
in the upper half of the Banking screen, Click each card / tile 10 select it and
add or match its activity. Preferred order - Credit cards first, then other bank
accounts, and finally main checking account.
Sunday Review & Match Fannm>ummummumoeomm- | ]
bank activity ded transaction. ¥ the Match tag is green, QBO has found
m ‘ agged Mwm"wmmummwmmmm
"Match®. muttiple matches. Click the row to view all matches and select the appropriate
Tuesday one. Clck the Match action 10 link the activity 10 the transactions.
Wednesday Review 8 Add  For Review > Recognized, Click the row to make any necessary changes. Click Il
bank acthvty the Add action, 10 accept the defined fiekds and add the transaction. Add the
Thursday wgged “Rule”,  customer If neeced,
m Review & Acd For Roview > Recognized. Click the row to make any necessary changes. Click
Saturday remaining bank  the Add action, 10 accept the suggested fiekds previously used for this
activity for marchant and add the transaction
which QBO
recognizes the
merchant
Review 8 Add  For Review tab > All button. If QBO did not suggest a Match, but you know the I
ining bank  tn ction is p d 10 the General Ladger and is not reconciled or matched
activity that to another transaction, clck the row and select the Find Match option. QBO's
QBO does not *Maich Transactions® screen will show al of the avalable amounts that you
rocognize. can match o,
Exciude activty  To permanently delote bank activity, exclude &, then go to the Excluded tab to
that is duplicate  select and delete
or aiready
reconciled

1n QuickBooks tab click the ik for sach transaction added 1odiry and attach
receipts as needed 52



System > Onboarding > Phase #4 > prep next phase

+—t Schedule "Transition
& Meeting" with client,
send Agenda

>

Update "Onboarding
ES Status Tracker”

)

|

1 Schedule
aero Phase5 tasks

)g

@ Gliickbooks.

CONNECT

Schedule Phase #5 Transition Meeting with client,
Onboarding rep and service team. Send agenda to

Update *Client Onboarding Status Tracker" for this
Phase to "Done*

Schedule Aero for OB Phase #5 - Transition
Meeting

53



System > Onboarding > Phase #5 Transition Meeting

‘aero Work  Manage Setp Ouck ks LBeay  Adwn Ml lnerwt Logen ©
Client Onboarding Phase #5: Training & Transition
Narme Descriotion Resources

Upciae *Clert Orboanaing Status
Teachar® for Bhin Phase 1 'In Progmess”

Prepace for meeting - review agendca &
Dreg wONSOMCo

Welcome chent, Introduce team on the
Have et share scree

Tran chent on Tearmwork

Train chent 00 acooumiing wystem

Aeview anc reindorce age e, per
erQaQerent Wl / Propons

Review Status of Tracked Neevs & Setun
wors

Dacuns any cheanup or catchup work
ant chart ervobvement

Koo 2 It of addmondl Lashs o AcSons
Dertited Owng Meetng Tat nedd 10 te
scheched. Create seros for aach after
g

End mestrg

Updane “Clent Onboarang Statia
Teacker” for this Phase % "Done”

mad 8 meeting sammary to the chent

Ensure your workaace a Clean ahelher Mmestng N person of wriualy If meetng vrtualy, enaure
YOUr webCHT & working and yOur AP0eWENce IS Camend-seady - st IMpressions maneet

Thank the chent again for Tholr DUsiness and jot Tham know yOu Snd yOur Seam are excited 10 be
working with Sem. Don Y just dive nght ndo the aderintrative Saska

Share chert screen 30 that thay can dove

Explan agan how 50 sconta the link in Clenthiuty > Appe section for Tckets and log . Show thes
e Weloome omal is Mere. Explan 1hat vy other omals rom Dem or Ayone with tha Company
Gomain name can De found & tracked hew

Row Tl CCOUNing Bystam works hom theer pengectve how they @0 ther partl Ae-do the sales
Sorno DUt with the Chent's speciic i Tha frna. Wik Bhern through he sute of softwire ook they
Wil Do Usng. the fregquency work will be done Emphasize e benefits 10 the clent of sach app and
maybe share with the clert why your S has chosen sach partculs spp.

review Seguency of service

Tt Samy logged im0 Asrc and Cratie melited Asrts ity aach Outslanding Serm s that notheg sips
Twough the oracks.

Congratsate them on completing the Onb
ol of arry OASIANSNG Berna dus from thes

g and gve them 3



System > Onboarding > Phase #5 > training

CUSTOMEA [P tal CREATID PREOMTY =
Voo erancu Dushboerd Geses reschedule T My Test Company
Redmond Accounting Inc Starting on January 1, 2019
Jason Fleming Tearmwork Desk Demo e g
By Cara Deasy Teamwork Desk wetinar
P g 4 marses o - Tracked items
1. Structure
#5y Avna Deasy We lowes = ALL OPEN Remind all
- Sde « System Architecture o
B S012121S e ~ * Client Hub Diane Csomok oM - May 16 Open
s ot Weson Chent visk « Genius Bar : e
Marteurg Watch Client Hub Welcome Video.
Mark as done
Vara Herrnander DESE TEST 3
“ Mortung 2. Accounting
£ barry Sman Feadback . Zleconc:'c &';ewow, Monthly Bank Access - Please provide a list of Bank
Mavw s . ose, Mon:
. 4 Names and Account Numbers that your
« Cash Flow, Monthly
e Lisa Jones Chent visit * Controlier Call, Monthly company.uses
“ o * Reporting, Available 24/7 1, Select a file to upload
. Diane Csormok 12 09 PAL W 12 Opea
3. Bookkkeeping
Please attach a copy of the current YTD
bank reconciliations and statements
@ I, Select a file to upload
Please provide a copy of the company Q‘
w9
1, Select a file to upload
InYUT
@ Giickbooks.

CONNECT



System > Onboarding > Phase #5 > status complete

Client Onboarding Status

TASK STATUS STARTDATE DUEDATE % COMPLETE NOTES
Welcome Client 107372019 10872019
Kickoft Mesting 10872019 1072019
Gather Info 1092019 103012019
R Lo 104302019 1472019
Transition Meeting 11/4/2019 152019

@ Gliickbooks.

CONNECT #QBConnect @Redmond_Laura
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System

@ Quiickbooks.

CONNECT

(o, )

How will you manage?

The firm is responsible for planning its success
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Results
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Average Actual Time For Master Aeros By Company
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Results > Service >

@ Quiickbooks.

CONNECT

ik Agprovals

Controller > payables

O 7 Dy

84782 2

I

Dys 7+ Dy

$45.386

Omis

2 %
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Tot 1o pay
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Results > Service > Controller > expense reports

mru

CON\I ECT

Reports Mew Ropont | =
Advanced Search  neset 4 »
From 0 A Exgonses oo
A Submtters St Ve A poicses Srow 50 Reports
GETED G v R ° >
Ny Exgorse N - et Wt LAt s hadide L e’ et add S SR Wy 2 0
$57.48
Trarsfor Tead ? rvocrg Yol Corporae wTOAYT T ERese rarage rehSesperncor o M (L
ovreen ]
ﬁ W DoubleCheck —mwmmwm
Naray | aparina R -51 verified m—
ASHOGM C——
United Airlines $1,003.50 —
. [ oo
wE t R,
ss -
Violations:

1. Expense exceeds maximum expense limit of

$500.00/person

2. Expense amount is 0.35% greater than the receipt

amount of $1,000.00

Item 1 of 4 View

Approve

Reject
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Results > Service > Controller > payroll

® Y @ @

Payroll journal Year to date Agency payments Time off balances
View your amplopess’ past earmings. View your emgioyees’ yeor-10-dote eomings, See off tax ond employes gornishment View your employees’ accruals and balances
deductions, ond toxes Secuctiors, and taset poymants thot Guato hot made on your beholl for each policy.
View > View ? View > View >
i Q Ly m
Employee summory Bank transactions Benefits report Time off requests
Al the detols : > :‘" every bonk account tansoction inftioted See company comributions ond empicyse View you.r employees’ requested, approved,
. RS ] (P vl Grnta deductions for the banefits you provide and declined requests.
View ) View View ) View >
@ Giickbooks.

CONNECT 62



Results > Service > Controller > ledger

Bookkeeping review Accourtast.only vew  Feedtak?
Stay efficent and plan ahead with this snapshot of your chent's books &
> COMPANY SETUS
» BANKING ACTIWITY

v COMMON 55085

Find other accourts m QuchBooks Ondre thar may need your stention

Undeposited funds -- Opening batance equity $0.00

Account noe created

Uncategorized asset 0 Negative asset and habiity accounts 0
Y] L
Uncategorized income 0
Uardachons
Uncategorized expente 2
trarsectons

~ TRANSACTION VOLUME  Last 30 days v

Figern out your workioad for tha chent

Bank transactioos Irvoices Bills 8ill paymanes
755 90 251 276



Results > Service > CFO > insight

Health Overview Risk Indicators CURRENT RATIO
Determined by dividing Current Assets by
il o X wm w2 nn 014 » w12 201 2004 Current Liabilities
Waeme ey ¥4 ¥4Y e ot Cash Dachning 2 a a A MEANING
. 381 98 541 . If the ratio is 1.35, that means there is $1.35 in
coss ’ L e . oo Receivabies Agng A4 v v A\ 4 current assets to pay every $1.00 in current
Fapmrses 8223 1332 1219 L) 126l liabilities
EBITDA . 0 0y st ey Ouining v a v A WHY YOU CARE
Alo nt ratio indicates low solvi for
DSCR -2 - T 2.4 | i  Expenses ve. Reveous A A A v g tmlinitic o~ e
Mahsancing No No No Yes POSSIBLE CAUSES OF ALOW CURRENT
RATIO
Ratios Asset Ratios o Current liabilities are too high
o Using short term funds (current liabilities)
N o W2 2 WM ne Wy o m2 N9 =M ik o decsed
Currert Ratio 5.2 -8 1.08 2.8 R 9.21 Q.63 4% > O POTENTIAL SOLUTIONS
Qukih Raso 2.60 -3, 4 .83 2.0 2,01 | Flagged becauss & s below Be industry - 2 L © Move some short term liabilities to long
average of 3.0 term
Debt | Equity .4 8,32 .1 .M LM - e w.» 9 o Sale/leaseback some of the fixed assets
Gross Margin $4. 194 1.92% 34,944 .34 3 ‘"0 AR Turnower “230 .0 WM. A ™ ‘.0 ™
Mot Mo gin 9.0 3. 0N 5. TH T.82% « aysom AR Duys =1. 44 S0 3.9 9.9 AR
ROA 1,30 2.00) T 1620 Cash Impact Map = Working Capital =
1.3 LA s " Covet Marge — e
~ Vg e
Mory Hatne I
—- YN —
AS Dlagn -
o Doye — < Can
FEETY 1 we e ~ e 0% - v @ tviery
Tonsl bmpict = SSLARATS S Ar
via il ’ SN
Sales [ Expenie Trending = Debt Ratios =
1R |
Aees Profe
. " - i -
o S a el
- COns
“.”"‘ ') S AR
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Results > Service > CFO > strategy

QUARTERLY ROCKS

1

6:16:
Acc Rock Agenda
Sepe
Scorecand a
Trifold brochure, proposal template and website draft ,‘:‘;,",“
complete Bein

plan

mv

@ Giickbooks.

CONNECT
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Complete departmental p
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View V710 >
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o

lDS = Courves . ClearSelection [3Som « F Notes S Newlssue D New Tado

& Bl Next Generation Technology

o . Accounting Software

& [l Finance Department Level 10 Meeting
& I Revise financial department structure
& B Technical Training

© Il Marketing Process

) Bl scorecards & Measurables for all
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Results > Service > CFO > automation

Asset Details

Add rewr o O eantng obiwe 2 oY
Description

T M 27"

Corf\gaomariardnae

these are e Setahy refated (o poocrmar, harddewe, RAM, montor, stz

Confiparinanioftnan

1hese a0 T detaly rvlated to 0%, weruon, et

Lagv
oo

Ser WNTDr

1245470

P haseOute

fon G5 201%

PurcrassArmonnt

100
=2

@ Gliickbooks.

CORNECT #QBConnect @Redmond_Laura

AvwtCategery

Locmon

© trplopes (| Cuntomer

Ervgioyee

O m—

B wactive

| € Marage Catngnries
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Results > Service > Support > response rate

) o
. L~ "

Reports o
Tichety
Resolution Time Average First Response Time
1d 5h 8m 1d 5h Om

@ Guiickbooks.

CONNECT

67



Results > Firm > Sales > engagements

Revenue © Payments
Projected Total Invoiced Unbilled Projects > Monthly Average Projected Total Collected Scheduled Recurring Scheduled Project
$422.69k $102.17k $1.91k $34.72k $407.93k $92.45k $311.44k $0
T [:J‘ year T 37; :1.1,1
Avg. Client Revenue New Client Revenue Avg. Team Revenue 122 Clients Enabled 5 Rejected » 19 Expiring Cards Awaiting Verification »
$1.58k $20.92k $46.30k 44% $2.25k $46.76k 5
+ :v'-"v a5t yoar
Jul Aug Sep Oct Nov Dec Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec Jan Feb Mar Apr May Jun
Clients Pipeline ©
Current Clients New Clients $73.37k Sent Total Accepted Total
463 18 $73.37k $45.83k
a% 6% 85%
T L‘a',' Month i T
= P ° ° * * ad $45.83k
i > ——— Conversion ($) Conversion (Proposals)
62% 58%
T 5% l 9%
New MRR Time To Accept
Sep Oct Nov Dec Jan Feb Mar Apr May Jun Jul Aug $3.62k 8 hours
17 Sent 10 Accepted e \ A

@ Giickbooks.

CONNECT



Results > Firm > Marketing > click rates

Automation Reports / Orip Campaign, New Leads / Cortacty

% tapont
4806 33.7% 29% 4.8 weeks
w1 Eere e an Bty Tty Lt S dgre Aawimge V Vou :
L Mt P Aatt 30 days g
Top Performing Tags Fop Performing Listy Top Completion Tirmes
Dhse PN of concact automati s 100% of COMACT Mttt oo SL2% of concact avtoman
[ rgagea 35.5% of conmact automats . Nenr e % of contact avtomatons 23 weska 1% of contact automasons
Rncere actviy 12.9% of contact astomatl . Parzeny 0.9% of concact sstomatio.. L0 weeky 0.6% of contact sutomatio..

mru

CON\I ECT

ENGAGEAME NTY
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FRRAnannmn 186
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Results > Firm > Operations > practice management

Average Actual Time for Master Aeros by Company

Last Week
9/22/2019 - 9/28/2019

Actual vs Estimates by Company

Last Week
Time Entries By Company W/22/2019 - 9/26/2019
Last Week
9/22/2019 - 9/28/2019
Open Aeros Overdue
Last Week
Support Hours 9/22/2019 - 9/28/2019

Last Week
9/22/2019 - 9/28/2019

@ Quiickbooks.

CONNECT
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Results

:

anr

@ Gliickbooks.

CONNECT

> Firm > Finance > profitability

i!
i

#QBConnect

@Redmond_Laura

o

Last Month
8M72019 - /3172019

Tunes Notes Acro Sutject  Project Nale Neveroe Comt
QR0 Rarwing Feads QB Ranking 0 30 %0
S
Northdy Bookioseping Al Bank Moy Y000 208 e
statemanty Fockesagay
meetng g $20000 S0008 ScO.00
BOC: Pay B DT Pay D ®©00 L 0w
BOC: Pay Bin, Deterrare cah SOC Pay e oo 9% | S35
regurwrent. Owterrrrs bty
avalaie
Feconcie Bas Accourdt - OBO, eyt b oo Sasr 2%
Aowrioad back Waterrect, Chooee Acotut - GO
acou 1o Neconcie, Check
Beogrrng Belance Lrter statersent
deta'a
Totat Totak:
S0  oass

L IR

L

$14004
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Results

(o, )

How will you know?

Watch your firm at work — improve, iterate, grow

@ Quiickbooks.

CONNECT
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If you define the problem correctly,
you almost have the solution.

Steve Jobs
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Questions?



Rate this Session on the QuickBooks Connect Mobile App

Provide feedback to help us design content for future events

1. Select Sessions 2. Select Session Title 3. Select Survey 4. Add Ratings

Wl ATAT LTE 6:48 PM @ ¥ 78% . Wil AT&T LTE 6:49 PM @ 7 76% - ol AT&T LTE 6:50 PM @ 7 76% - Wil ATET LTE 6:50 PM @ o 75 .
- O gackbooks — J— &
A CONNECT = = Sessions Q < a, o
QuickBooks Connect San Jose November 5" e — Session Surveys
MEEVE Nowv 06, 7:30 AN Small Group Discussion: Social Media Strategy sabotage aspects and tangible strategies you can use to fix How would you rate this speaker?
@ Braindates the cash flow crunch once and for all.
Kim Tchang Nov 07, 9:00 AM - 10:00 AM POT e . » e E
. ] nce: llyOH(_‘ managing sma usiness hinances.
. ) Nov 06, 7:30 AN @ 10 Thin eal Audier
e gs The Most Successful Bookkeepers Will
o/ MySessions o Registration, £ Be Doing In 2020
BEST FOR
* My Favorites Nowv 06, 8:00 AN Nov 07, 9:00 AM - 10:00 AM PDT Poor Excellent
(+) Meetup: Busir () Becoming an Apps Master: Connecting Apps the Business Owners/Self
B  Notifications Fecebook Gre Right Way to the QuickBooks Online Database How would you rate this Session?
EVENT GUIDE Nov 06, 9:00 AN @ Nov 07, 9:00 AM - 10:00 AM PDT LEVEL
4 bi & Accountant K " Building the People Firm in the Digital World Beginning ﬂ
cover
-—
Nov 06, 10:00 A . Nov 07, 9:00 AM - 10:00 AM PDT
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Material Download

1. Find the session on the agenda
2. Select + for more information

3. Download PDF of slides and/or
supplemental material

https://quickbooksconnect.com/agenda/
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Breakowt Sessions

Small Business Meetup: Relationship Marketing and the Power of Human
Connection
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